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Preface

Preface

Audience

The purpose of this document is to provide you with an overview of the possibilities
offered by SAP ERP Knowledge Modules and how to use them in Oracle Data
Integrator.

This document provides examples to help you understand how to achieve an ETL
project with Oracle Data Integrator, loading a Data Warehouse with data from SAP
systems, while validating data quality.

This project should take approximately 90 minutes to complete. You may save your
work in order to pause and resume at any point in the project.

It is recommended that you use Oracle Data Integrator before proceeding with this
guide. A good introduction to Oracle Data Integrator is the guide Data Integrator
Getting Started.

It is recommended that you also review the SAP ABAP chapter of Application
Adapters Guide for Oracle Data Integratorfor more information about the SAP ERP
KMs.

This document is intended for developers and administrators who want to use Oracle
Data Integrator Application Adapters with SAP ERP systems using SAP JCo libraries,
as a development tool for their integration processes.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the
Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Related Documents

ORACLE

For more information, see the following documents in Oracle Data Integrator Library.

* Release Notes for Oracle Data Integrator

*  Understanding Oracle Data Integrator
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Conventions

The following text conventions are used in this document:

ORACLE

Preface

Administering Oracle Data Integrator

Developing Integration Projects with Oracle Data Integrator
Installing and Configuring Oracle Data Integrator

Upgrading Oracle Data Integrator

Application Adapters Guide for Oracle Data Integrator
Developing Knowledge Modules with Oracle Data Integrator

Connectivity and Knowledge Modules Guide for Oracle Data Integrator
Developer's Guide

Migrating From Oracle Warehouse Builder to Oracle Data Integrator
Oracle Data Integrator Tools Reference

Data Services Java API Reference for Oracle Data Integrator

Open Tools Java API Reference for Oracle Data Integrator

Getting Started with SAP ABAP BW Adapter for Oracle Data Integrator
Java API Reference for Oracle Data Integrator

Oracle Data Integrator 12c Online Help, which is available in ODI Studio through
the JDeveloper Help Center when you press F1 or from the main menu by
selecting Help, and then Search or Table of Contents.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for

which you supply particular values.

nonospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.

Vii



Overview of Oracle Data Integrator SAP
ERP Knowledge Modules

This chapter provides an overview of Oracle Data Integrator SAP ERP Knowledge
Modules.
This chapter includes the following sections.

1.1 Overview

The Oracle Data Integrator SAP ABAP Knowledge Modules provide integration from

ORACLE

SAP ERP systems using SAP JCo libraries. This set of KMs has the following
features:

* Reads SAP data from SAP ERP system

e Loads this SAP data into Oracle or non-Oracle Staging Area

* Reverse-engineers SAP metadata and proposes a tree browser to pick up only the

required metadata

This adapter includes three knowledge modules:

 RKM SAP ERP: Its main role is to perform customized reverse-engineering of
SAP tables into ODI datastores (Models). The SAP ERP RKM is in charge
of connecting to the SAP System, which provides the SAP table's metadata

information, and transforming and writing the resulting metadata into Oracle Data

Integrator's repository.

* The LKM SAP ERP to Oracle (SQLLDR) connects to SAP and retrieves data
from the SAP tables defined in the SAP Model. It is used in the mappings. The

LKM is in charge of loading source data from a SAP System to an Oracle staging

area.

¢ The LKM SAP ERP to SQL connects to SAP and retrieves data from the SAP

tables defined in the SAP Model. It is used in the mappings. The LKM is in charge

of loading source data from a SAP System to a non-Oracle staging area.
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Setting Up the Environment

This chapter describes how to set up your SAP ERP environment for use with Oracle
Data Integrator.
This chapter includes the following sections:

2.1 Before You Begin

Before you begin, consider the following:

2.1.1 System Requirements and Certification

ORACLE

Before performing any installation, you should read the system requirements and
certification documentation to ensure that your environment meets the minimum
installation requirements for the products you are installing.

The Oracle Data Integrator requirements are listed in Installing and Configuring Oracle
Data Integrator.

The requirements specific to the Oracle Data Integrator SAP ABAP Adapter are:

e Oracle Data Integrator 11.1.1.7.0 or above.

" Note:

Most of this documentation also applies to the SAP connectivity in
Oracle Bl-Applications, which requires Oracle Data Integrator 10g,
as specified in more detail in System Requirements and Supported
Platforms for Oracle Business Intelligence Applications for SAP.

e A Java Connector (JCo) version compatible with adapter must be used. The list
of supported JCo versions is available in the Certification Matrix available from
Oracle Technology Network (OTN). A minimum version of JCo 3.0.2 is required.

e A JVM version compatible with both Oracle Data Integrator and JCo must be used.
A minimum version of JVM 1.5 is required due to JCo pre-requisites.

e The connector supports two transfer modes for transferring data from SAP system
to the ODI agent: data transfer using a Shared Directory and data transfer through
FTP. For details and restrictions, see File Transfer Considerations of Application
Adapters Guide for Oracle Data Integrator. Depending on the chosen file transfer
mode the following requirements must be met:

— Data transfer through a Shared Directory (recommended transfer
method) The LKM SAP ERP to Oracle (SQLLDR) requires a folder that is
shared between the SAP system and the ODI agent. The SAP application
server transfers the data by writing it out into a folder that is accessible from
the SAP system and the ODI agent machine. This is typically done by sharing
a folder of the ODI agent machine with the SAP system. Note that the shared
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Chapter 2
Before You Begin

folder does not necessarily have to be located on the ODI agent machine. A
shared folder on a third machine is also possible, as long as the shared folder
is accessible to both the ODI agent machine and the SAP system.

# Note:

For security reasons, the SAP folders should not be shared with the
ODI agent. Share only folders of the ODI agent machine with the
SAP system.

The shared folder must be accessible to SAP system and not just to the
underlying operating system. This means that the folder needs to be declared
in SAP transaction AL11 and the folder opens successfully in AL11.

— Data transfer through FTP LKM SAP ERP to Oracle (SQLLDR) requires a
FTP server to upload data from the SAP ERP system. This data is either
read locally by the agent executing the mapping (when this agent runs on the
FTP server machine), or remotely (when this agent is located on a different
machine than the FTP server). This FTP server must be accessible over the
network from both the SAP ERP machine and the agent machine.

e For LKM SAP ERP to Oracle (SQLLDR) only: SQL*Loader is required on the
machine running the agent the executed mappings using LKM SAP ERP to Oracle
(SQLLDR). SQL*Loader is used for loading data extracted from SAP to the Oracle
staging area.

2.1.2 Requesting ODI SAP Component Installation into the SAP

System

The ODI SAP adapter communicates with the SAP System using a few ODI SAP
RFCs. These RFCs are installed by your SAP Basis team using SAP Transport
requests. Please contact your SAP administrators for installing the ODI SAP
Components and assigning the required SAP user authorizations by following the
instructions given in the Installing ODI SAP Components section in Application
Adapters Guide for Oracle Data Integrator.

2.1.3 Requesting FTP Server Access

ORACLE

This section applies only if you plan to transfer data using FTP. You can skip this
section if you use a Shared Directory for the data transfer or if your SAP system is
older than the following:

« SAP ECC6 EHP6 or later
« SAP BWI/BI 7.4 or later

The following steps must be performed before any subsequent steps in this guide can
be performed. These steps are typically performed by your SAP Basis team. Failure
to perform these setup instructions will lead to FTP failure when running any ODI SAP
extraction jobs.

To request FTP server access:

1. Login to SAP server.
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Execute transaction SE16.

Enter SAPFTP_SERVERS in the Table Name field and click [ icon to create entries.
Enter IP address of the FTP server in the FTP_SERVER_NAME field.
Enter port of the FTP server in the FTP_Server_Port field.

Click icon to save.

2.1.4 Gathering SAP Connection Information

In order to connect to the SAP ERP system, you must request the following
information from your SAP administrators:

ORACLE

SAP ERP System IP Address or Hosthame: IP address/ Hostname is the
technical name given to the host on which SAP is running.

SAP User: SAP User is the unique user name given to a user for logging on the
SAP System.

SAP Password: Case-sensitive password used by the user to log in.

SAP Language: Code of the language used when logging in For example: EN for
English, DE for German.

SAP Client Number: The three-digit number assigned to the self-contained unit
which is called Client in SAP. A Client can be a training, development, testing or
production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance which is
also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP Transport Layer Name: This string uniquely identifies a transport layer in a
SAP landscape. It allows ODI to create transport requests for later deployment in
SAP. Even though there is a default value here, this transport layer name must be
provided by your SAP Basis team. Not doing so may result in significant delays
during installation.

SAP Version: The version of the SAP system.

SAP Character Set: The character set is only required if your SAP system is not
a UNICODE system. For a complete list of character sets, see "Locale Data" in
the Oracle Database Globalization Support Guide. For example, EE8I SO8859P2 for
Croatian Data. For UNICODE systems, use UTF8.

< Note:

All the connection data listed above (except SAP SNC Connection Properties
and SAP Router String) are mandatory and should be requested from the
SAP Administrators. You may consider requesting support during connection
setup from your SAP administrators.
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2.2 Validating the Shared Folder Setup

Validating a shared folder setup applies only if you plan to transfer data using a Shared
Directory. This section can be skipped, if the FTP transfer is used. The validation of the
shared folder setup needs to be performed before any subsequent steps in this guide

can be performed. This validation is typically performed by your SAP Basis team.

Step 1: Validating folder access from the SAP application server

Start the SAPGUI.

Go to transaction AL11.

Select the shared folder.

g H @ b P

Double-click the shared folder to test the directory declaration.

Use the ODI SAP user and password to connect to the SAP system and client.

This should report a successful connection. If not, please contact your SAP basis

team. Do not continue until this test passes.

" Note:

SAP uses the OS user <sid>adm to connect to the directories declared
in AL11.

6. Print screen.

Step 2: Validating folder access from the ODI agent machine

1. Log in to the ODI agent machine using the Windows user ID used for executing

the ODI agent.
2. Open shared directory path in Windows Explorer.

This should list the content of the shared folder. Please make sure that you do
NOT need to enter any credentials. If this does not work or you had to enter

credentials, please contact your windows administrator or the system administrator
of the system your shared folder is physically located on. Do not continue until this

test passes.

3. Print screen.

2.3 Validating the FTP Setup

ORACLE

Validating an FTP setup applies only, if you plan to transfer data using FTP. This
section can be skipped, if you use a Shared Directory for the data transfer. The
validation of the FTP setup needs to be performed before any subsequent steps in

this guide can be performed. This validation is typically performed by your SAP Basis

team.

Step 1: Validating SAPFTPA destination
1. Start the SAPGUIL.
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Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SM59.

Expand TCP/IP connections.

Open the SAPFTPA destination.

Click Test connection.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

Print screen.

Step 2: Testing FTP connection

® N o o k~ w NP

Go to transaction SE38.

View the function module RSFTP002.

Hit F8 to run the ABAP program.

Enter the FTP userID and password.

Enter the FTP server host name or IP address.
Entercd /orcd <ODI target directory>.

In the RFC_DESTINATION field, enter SAPFTPA.
Hit F8 to run the test.

This should report a successful connection. The message should be similar to the
following:

250 CWD successful .

If this test is not successful, please contact your SAP basis team. Do not continue
until this test passes.

Print screen.

2.4 Validating SAP Privileges

This section describes how to test some of the key SAP privileges. Proceed with the
subsequent steps in this guide only after successful validation of these tests. This
validation is typically performed by your SAP Basis team.

ORACLE

Perform the following steps to validate whether a SAP user has appropriate dev rights
and owns a dev license key:

6.

CAE A

Start SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SE38.

Enter any sample program name like ZSAP_TEST in the program name field.
Click Create.

Perform similar tests for the transaction SE37 and SE11.

If a transaction allows the creation of a program without asking for any key or other
authorization message, then the SAP user has validated that it has the appropriate
dev rights and license key. Otherwise your SAP basis team needs to register the SAP
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user in service.sap.com to get the license key and a Basis person can help him with
dev rights.

2.5 Validating SAP Transport Layer Name

As the SAP connector creates SAP objects, such as, for example, function modules,
into the SAP development system, these changes need to be transported into QA and
production systems once the development is done. The SAP's change and transport
system uses the SAP Transport Layer Name to identify the route a change has to take.
A transport layer is assigned to each development class and thus to all objects in that
class. The transport layer determines:

* In which SAP System developments or changes to the repository objects are
made

» If objects are transported to other systems within the group when development
work has been completed

A consolidation route is created from the development system to the quality assurance
system through the t ransport |ayer Z<SI D>. It then becomes the standard transport
layer for customer development and customizing.

A consolidation route is created from the development system to the quality assurance
system through the t ransport | ayer SAP for the transport of SAP Standard objects.

It is important to specify the correct transport layer name before running the RKM
SAP ERP for the first time. Perform the following steps to identify the list of defined
transport layers in your SAP landscape:

1. Log onin client 000 in the SAP System serving as the transport domain controller
via transaction STMS.

2. Select Overview > Transport Routes. The Display Transport Routes dialog is
displayed.

Select Goto > Graphical Editor.
To switch the mode, select Configuration > Display <-> Change.

Position the cursor on the SAP System.

o o p W

Select Edit > System > Change. The Change System Attriburtes dialog is
displayed.

7. Select the StandardTransport Layer tab.
8. Change the transport layer of the SAP System.
9. The result is the list of the different transport Layers.

By default, the RKM option SAP_TRANSPORT_LAYER_NAME is set to SAP. Ask
your SAP basis admin which transport layer you should use. This transport layer
name must be set on the SAP_TRANSPORT_LAYER_NAME RKM option. A wrong or
invalid transport layer name will cause serious delays during the installation process.

2.6 Installing Oracle Data Integrator

Before starting with this project, you need to install and configure Oracle Data
Integrator. See theData Integrator Getting Started and the Installing and Configuring
Oracle Data Integrator for more information.
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2.7 Installing and Configuring the Oracle DB Target

This project uses an Oracle database engine as the target and as the staging area for
the mappings. You can download for example Oracle Database 11g Express Edition
from Oracle Technology Network (OTN). Install and configure this database.

This project targets an Oracle table that can be created using the following script:

-- Create deno target schema

CREATE USER ODI _SAP_DEMO | DENTI FI ED BY ODI _SAP_DEMO DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TEMP;

GRANT CONNECT, RESOURCE TO QDI _SAP_DEMO,

-- Create deno target table
CREATE TABLE ODI _SAP_DEMO. W GEO DS (
LANGUAGE_KEY CHAR(20),
COUNTRY VARCHAR( 50),
COUNTY VARCHAR(50),
STATE_PROV VARCHAR(50),
NATI ONALI TY VARCHAR(50));

ALTER TABLE ODI _SAP_DEMOD W GEO DS ADD CONSTRAINT PK W GEO DS PRI MARY KEY
(LANGUAGE_KEY) ;

CREATE TABLE ODI _SAP_DEMO MARA_REPL| CATED

(
MANDT VARCHAR2(3 CHAR),

MATNR VARCHAR2(18 CHAR),

DELETED VARCHAR2(1 CHAR),

MEI NS VARCHAR2(3 CHAR),

CDHDR OBJECTI D VARCHAR2( 90 CHAR)
UDATE DATE,

TCODE VARCHAR2(20 CHAR)

)

2.8 Installing and Configuring JCo

The SAP adapter uses Java Connector (JCo) to connect to the SAP system. JCo must
be configured before proceeding with the project.

To install and configure JCo:

1. Download a supported JCo version for your configuration from http://
service.sap.com/connectors. Check the supported JCo version in the Certification
Matrix available at Oracle Technology Network. Note that a minimum version of
JCo 3.0.2 is required.
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< Note:

e Choose the SAP JCo package matching your operating system and
your system architecture (32/64Bit). E.g. if you are running ODI
inside a 32-Bit JVM, you must download the 32-Bit SAP JCo, even
if the CPU and OS are 64-Bit. Mixing 32-bit and 64-bit architecture
is not possible due to native libraries required by SAP JCo and will
result in connection failure.

e odi.conf contains the JDK path used for ODI Studio.

2. Unzip the appropriate distribution package into an arbitrary directory <sapj co-

instal | - pat h>.

3. Follow the installation instructions in <sapj co-i nst al | - pat h>/ j avadoc/

installation.htn for the respective platform.

4. Copy sapj co3.jar and sapjco3.dl|:

For ODI 10g: Copy sapj co3. j ar and sapj co3. dl | (or respective binary like
| i bsapj co03. so) into the oracl edi / dri vers directory.

For ODI 11g: Copy sapj co3.j ar and sapj co3. dl | (or respective binary like

|'i bsapj co03. so) into the <CDI _HOVE>/ odi _mi sc directory (ODI Studio) and into the
<ODI _HOVE>/ or acl edi / agent / dri vers directory (Standalone Agent) and into the
<WLS_DOMAIN>/lib directory (JEE Agent).

For ODI 12c: Copy sapj co3. j ar and sapj co3. dl | (or respective binary like
|'i bsapj co3. s0) into the <ODI _HOVE>/ odi / sdk/ | i b directory (ODI Studio, ODI
Standalone Agent) and into the <WLS_DOMAIN>/lib directory (JEE Agent).

5. Restart ODI Studio and any agents.
6. Check the JCo installation. This will be also checked later in this guide.

2.9 Configuring Oracle Data Integrator

Perform the following steps to configure Oracle Data Integrator:

2.9.1 Add the Open Tool

ORACLE

The complete process of installing and adding an Open Tool to ODI is described
in Oracle Data Integrator Tools Reference. This section details only the SAP ABAP
specific steps.

1. Connect to Designer.
2. Select ODI > Add/IRemove Open Tools...

3. In the Add/remove Open Tools window, enter the following name in the Open Tool
class name field:

oracl e. odi . sap. km _Cdi SapAbapExecut eSt oppabl e
4. Click Add Open Tool.

5. The Add Open Tools window appears as shown below.
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6.

To add an OpenTool, please add your OpenTool's JAR or ZIP files o ' <ide, user,dir »/oracledijuserlib’ folder, then restart Oracle ﬁ

. .;.Add Open Tools

Data Integrator, Please find <ide,user.dir > property in Properties tab of Help|About section.

Open Tool class name: | 4 @

OdiSAPA te "'~ =<upl ion>" "-EXECUTE= te option>" "-EX...
%_ iSAPAbapExecute "-UPLOAD = <upload option=" "-EXECUTE=<execute option Provider oradle.

This Open Tool will upload an ABAP program and also Extracts the data from SAP Systems, Version  10.1.3.16
To delete this Open Tool, cick Delete, Delets;
Help o Cancel
i T s
Click OK.

ORACLE"
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Configuring the Topology

This chapter describes how to configure the topology by using a practical example.
This project will integrate the following source and target data:

Source tables TOO5T and TOO5U are the tables from SAP containing geographical
information.

Target W_GEO_DS is a dimension table in an Oracle database that needs to be
loaded from the SAP Sources. This table contains geographical information such as
Continent nane, Country name, Regi on, State, County, City and Zi p code.

This chapter includes the following sections.

3.1 Configuring the File Server for SAP ABAP

ORACLE

Perform the following operations after installing or upgrading your Oracle Data
Integrator version:

1. Connect to Topology Manager.

2. If this SAP ABAP technology does not exist in your Master Repository, import
the SAP ABAP technology in Synonym INSERT_UPDATE mode from the /i npexp
folder.

3. Perform an upgrade of the Master Repository. Refer to the Installing and
Configuring Oracle Data Integrator guide, for more information on the Master
Repository upgrade process.

4. In Topology Manager, open the JavaBeanShell technology and check on the
Language tab that the JYTHON language is listed. If not, add it.

5. Create a File data server pointing to an existing FTP/file server into which the
extraction file will be pushed from SAP and picked up for SQL*Loader. For
use with FTP transfer, set the following parameters. For use with shared folder
transfer, the settings on this data server do not matter.

Host (Data Server): FTP server IP host name or IP address.
User: Username to log into FTP server.

Password: Password for the user.

For use with "LKM SAP ERP to SQL" these additional parameters must be
configured:

JDBC driver class: com.sunopsis.jdbc.driver.file.FileDriver
JDBC URL: jdbc:snps:dbfile?ENCODING=UTF8

The above URL is for SAP UNICODE systems. For non-UNICODE systems,
please see details on ENCODING parameter in Creating a File Data Server
section of Connectivity and Knowledge Modules Guide for Oracle Data
Integrator Developer's. Please note the encoding chosen on this URL must
match the code page used by the SAP Application Server.
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7. In this File data server create a Physical Schema representing the folder in the
File server to which the extraction file will be pushed. For use with FTP transfer,
see details below. For use with shared folder transfer and for more details, see
Transfer using a Shared Directory (recommended) section of Application Adapters
Guide for Oracle Data Integrator Guide.

- Data Schema: Path on the FTP server to upload or download extraction files
from the remote location. This path is used when uploading extraction files
from the SAP ERP system into the FTP server. It is also used by a remote
agent to download the extraction files. Note that this path must use slashes
and must end with a slash character.

*  Work Schema: Local path on the FTP server's machine. This path is
used by an agent installed on this machine to access the extraction files
without passing via the FTP server. This access method is used if the
FTP_TRANSFER_METHOD parameter of the LKM SAP ERP to Oracle
(SQLLDR)/ LKM SAP ERP to SQL is set to NONE. As Work Schema is an
OS file name, slashes/ backslashes should be used according to OS.

Path names need to end on slash/ backslash. Path names given on Data and
Work schemas are not necessarily the same: the FTP service may provide
access to a FTP directory named / sapfi | es while the files can be stored
locally in c: \'i net pub\ ftproot\sapfiles.

Refer to File Transfer Considerations section of Application Adapters Guide for
Oracle Data Integrator Guide.

8. If the corresponding Logical Schema called Fil e Server for SAP ABAP does not
exist yet, create it. This Logical Schema name is fixed and must be mapped to the
Physical Schema created in the previous step.

3.2 Configuring the Target Data Server

This section describes how to setup an Oracle Data Server. Please use respective
settings when configuring a non-Oracle Target Data Server for use with LKM SAP ERP
to SQL.

1. Connect to Topology Manager.

2. In the Physical Architecture tree view, expand the Technologies node and select
the Or acl e technology.

3. Right-click and select New Data Server.

4. Enter the data server Definition as shown below:
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Test Connection

Definition

IDEC

On Conneck/Disconnect
Properties

Datasources

Wersion

Privileges

Flexfields
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™ Data Server

Mame: |ORF'.CLE_TF'.RGET

Technology:

Instance [ dblink (Data Server): |><E

Connection

User: |ODI_SAP_DEMO

PaSSWDrd: (LTI L)

[] INDI Connection

Array Fetch Size: Batch Update Size:

5. Select the JDBC tab, and enter the JDBC connection information to your data
server as shown below:

™) ORACLE TARGET

Test Connection

Definikion

IDBC 1DBC Driver: |oracle,jdbc, OracleDriver

0n ConneckfDisconneck jdbcioracle: thini@localhosk: 1521 XE
Properties ADEBC Url:

Datazources

Make sure to change the URL to match your Oracle instance configuration.

© ®» N o

Click Test Connection to test the connection to this data server.
From File menu, click Save.
Right-click the data server you created and select New Physical Schema.

In the Physical Schema windows that appears, select the ODI _SAP_DEMO for both

Schema and Work Schema.

If you already have a Work Schema for ODI defined for this data server, you can
use it instead of the CDI _SAP_DEMO Schema.

10. Go to the Context tab.

11. Click Add and enter in the Logical Schema field the value ODI _SAP_DEMO.

12. From the File menu, click Save.

3.3 Configuring the SAP Source Server

The following topics describe how to configure the SAP source server.

ORACLE
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3.3.1 Configuring the Data Server

ORACLE

Except for the data server name, all the parameters that you provide while defining the
SAP Data server should be provided by the SAP Administrators. See Gathering SAP
Connection Informationfor more information about these parameters.

1. Inthe Physical Architecture tree view, expand the Technologies node, select the
SAP ABAP technology.

2. Right-click and select New Data Server.
3. Enter the data server definition. Set the parameters for this data server as follows:
* Name: SAP_ERP. The name of the data server as it will appear in ODI.
e Host (Data Server): SAP ERP System IP Address or Hostname.
e User: SAP User, as provided by the SAP Administrator.
« Password: This user's SAP Password. This password is case-sensitive.
4. Set the Flexfield values for this data server in the Flexfields tab:

e SAP Language: Code of the language used when logging in. For example EN
for English, DE for German.

e SAP Client Number: The three-digit number assigned to the self-contained
unit which is called Client in SAP. A Client can be a training, development,
testing or production client or represent different divisions in a large company.

e SAP System Number: The two-digit number assigned to a SAP instance
which is also called Web Application Server or WAS.

e SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

e SAP Character Set: The character set is only required if your SAP system is
not a UNICODE system. For a complete list of character sets, see "Locale
Data" in the Oracle Database Globalization Support Guide. For example,
EE8I SOB8859P2 for Croatian Data. For UNICODE systems, use UTF8.

" Note:

This FlexField is only used with "LKM SAP BW to Oracle
(SQLLDR)". For use with "LKM SAP BW to SQL" please define
the character set using the ENCODING parameter in the file driver
URL, as described in Configuring the File Server for SAP ABAPfor
non-UNICODE SAP systems.

* SAP ABAP Version: Enter the SAP ABAP version as follows:
— For SAP 4.6C enter 46C
— For SAP 4.7 enter 620
— For SAP ECC 5.0 enter 640
— For SAP ECC 6.0 enter 700
* SAP BW Version & SAP ERP Version: unused in SAP ERP Connector.
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5. From the File menu, click Save.

# Note:

The Test Connection button for validating SAP Connection definition is
not supported for this connection.

3.3.2 Configuring the Logical Schema

1. Inthe Physical Schema window, do not edit the Definition tab.

2. Select the Context tab, click Add and enter the Logical Schema name
LOG CAL_SAP_ERP.

% cap_ERP_DeFault

Definition
Context
Yersion Conkext Logical Schema
s Development OeICAL_SAP_ERP
Privileges
Flexfieglds

3. From the File menu, click Save.
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Creating a New Project

This chapter describes how to create a new Project for SAP.

In order to work with the data servers you have created, you must create a project and
import the appropriate knowledge modules for reverse-engineering the data structures

and integrating the data.

4.1 Creating a New Project

ORACLE

To create a new Project for SAP:

Connect to Designer.

In the Projects tree view click New Project.

In the Definition tab, enter SAP Deno for the Project name.
From the File menu, click Save to save your project.

Expand the SAP Denp Project, select the First Fol der node.
Rename this folder to SDE_SAP_GeoDi nensi on.

Right-click the SAP Deno Proj ect in the Projects tree view.

Right-click and select Import > Import Knowledge Modules.

© ©® N o o p W Db PR

Select in the File import directory the directory containing your KMs. By default,
they are located in the . . /i npexp directory.

=
o

. Select the following KMs:

e |KM Oracle Incremental Update
LKM SAP ERP to Oracle (SQLLDR)
LKM SAP ERP to SQL
* RKM SAP ERP
* RKM SAP ERP Connection Test

11. Click OK to perform the import.
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Reverse-Engineering Data Models

This chapter describes how to reverse-engineer the Oracle target and SAP source
data models.
This chapter includes the following sections.

5.1 Reverse-Engineering the Oracle Target

To reverse-engineer the Oracle data model:

1. Connect to Designer.
2. In the Models tree view, click New Model.

3. In the Definition tab, enter the model parameters as shown below:

|z Oracle Target

f@ Reverse Enginesr | & Generate and deploy
Definition e

3 Mode
Reverse Engineer
Zontrol Mame: ZIZ'r'an:IEe Target
Jodtrel el o |ORP.CLE_TP.RGET
Journalized Tables
Services Technalagy: | Oracle
Markers Logical Schema: |ODI_SAP_DEMO
Mermo

. Ackion Group: | <Eeneric Acktion =

Wersion
Privileges Default Folder: |
Flexfields

Descripkion:

4. Inthe Reverse Engineer tab, select the Global context.

ORACLE
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Oracle Targst
@ Reverse Engineer V

Definition

Reverse Engineer
Selective Reverse-Enginesring
Control

Journalizing
Journalized Tables
Services

Markers

Memao

\ersion

Privieges

Flerxfields
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Generate and deploy

(3)5tandard () Customized

Conkext: | Glabal

Lagical Agent: |Local (Mo Agent)

Types of objects to reverse-engineer

Table View Queue

Mask:

[]Swstem Table [ Table Alias

[] s¥nonym

Yo

Characters ko Remove from Table Alias: |W

Table Alias maximum length: |35

5. Click Reverse Engineer, and then save your model.

6. The WS_GEO_DS datastore appears in your Oracle model, as shown below.

—| Models

il -

' J?‘_ Used by
; % Diagrams

&by, Hierarchy

D TARGET_INTERWAL_HIERARCHY

._'.j TARGET_MNAVIGATIONAL_ATTRIBUTE
B W_ACCNT_VENDR_DS

-[wW_GED DS

5.2 Reverse-Engineering the SAP Source Datastores

To reverse-engineer the SAP Source datastores you need to perform the following

tasks:

This section also includes the following topics:

5.2.1 Creating the Data Model

1. Inthe Models tree view, click New Model.

2. In the Definition tab, enter the model parameters as shown below. You must
select the SAP ABAP technology and the Logical Schema previously created (in our
example it is the LOG CAL_SAP_ERP Logi cal Schens).

ORACLE
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i S4P ERP SOURCE
(B reverse Enginesr o

Definition

Reverse Enginest

Conkral

Journalizing

Journalized Tables

Services
Markers
Merno
Version
Privileqes
Flexfields

3.
4.

Generate and deploy
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Model
Name: 4P ERP SOLRCE
Code: |S.'5.F‘_ERF‘_SOLIRCE
Technology: | SAP ABAP

Logical Schema:

Action Group:

Default Folder:

Description:

|LOGICAL_SAP_ERP

| <Genetic Action >

In the Reverse Engineer tab:

a.
b.

C.

Select the d obal context.

Select Cust omi zed option.
Select the RKM SAP ERP Connection Test you have imported in the SAP ERP

Deno project.

5.2.2 Validating the SAP Connection

In the Models tree view, open the SAP ERP Sour ce Model.

ORACLE

Click Reverse Engineer and confirm the start of the reverse-engineering process.
This process runs two tests:

Establish a test connection to the SAP system and

Validate the proper setup of SAP JCo by displaying the About dialog.

In a few seconds, you should see the SAP JCo-About dialog as shown here:
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SAP Java Connector (JCo) E] a E|

THE BEST-RUN E-BUSINESSES RUN SAP Sar

SAP Java Connector (JCo)
Copyright () 2000-2007 SAP AG, All rights reserved
Java Runtime
Operating System: Windows XP 5.1 for x86
Java VM 1.6.0_14 Sun WMicrosystems Inc

Java Codepage: Cp1252

Versions

JCo API; 3.0.2 (2009-03-29)
JCo middleware name: NEW=I{S

JCo middleware: 211

JCo middieware native, ERERCE!

Paths

AProgram®20Files\Oracleloracledi_101351wracleditdrivers\sapjcod jar

)

JCo classes:

JCo library \Program Files\Oracle\oracledi_101351\oradedidriversisapjco3.dil

[ cise |

(9]

Please verify the JCo version number (see System Requirements and
Certificationfor more details) and verify that a path for the JCo Library is given
(. dl'l for Windows). If this is not the case or you see any error message in this
about dialog, please review the SAP JCo installation, as described in your SAP
JCo package, and run this test again.

" Note:

Closing the JCo-About-Dialog will also close ODI.

4. Once you have validated SAP JCo installation, open ODI Operator.
5. In the Operator, expand the Reverse-Engineering session down to the task level.

6. Verify whether the task "Test SAP Connection" has been executed successfully. If
not, view the task details to identify the connection problem. The output of this task
must contain Successful |y connected to SAP System If not, the connection test
has failed and the connection problem must be analyzed before you continue.

Do not continue until you have successfully validated the SAP connection!
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< Note:

If you want to validate the SAP connectivity independent of ODI, please see
SAP Stand-Alone Connection Test.

5.2.3 Starting the Reverse-Engineering Process

To start the reverse-engineering process of the SAP ERP datastores:

1. Import TR.

" Note:

See also, Installing SAP Transport Request (TR) in the Application
Adapters Guide for Oracle Data Integrator.

2. In the Models tree view, open the SAP ERP Source Model.
3. Inthe Reverse Engineer tab:
a. Selectthe G obal context.
b. Select the Customi zed option.
c. Select the RKM SAP ERP you have imported in the SAP ERP Denp project.
d. Setthe USE GU KMoptiontotrue.
e. Set UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE to False.

Caution:

Make sure that you provide the correct value for the
SAP_TRANSPORT_LAYER _NAME opti on.

f. Set other parameters according to your SAP configuration. See the Application
Adapters Guide for Oracle Data Integrator for more information on the RKM
options.

4. From the File menu, click Save to save your changes.
5. Click Reverse Engineer to start the reverse-engineering process.
6. Click OK.
The Sessions Started Dialog is displayed.
7. Click OK.

5.2.4 Using the SAP Metadata Browser

As you have set the USE_GUI option to Yes, the RKM displays in the SAP Metadata
Browser the SAP objects organized in the tree view as shown below.
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¢ Note:
log messages for details.

for more details.

--l% 58P Metadata Browser

In case that the below dialog does not show up, see ODI Operator and ODI

Refer to Log Files in Application Adapters Guide for Oracle Data Integrator

[ 2] AC (Accounting - General)
g 2] Al (Auko-ID Infrastructure)
=3 AP (Application Platform)
i BC (Basis Components)
23 BW (SAP Business Information Warehouse)
=4 CA (Cross-application Basis Components)
= OO (Contralling)
= 5 {Customer Service)
2 EC (Enterprise Cantraling)
3 EHS {Enwironment, Health and Safety)
2 EP (Enterprise Portal)
21| FI {Financial Accounting)
2 FIN (Financials)
= FS (Financial Services)
= HUG {Product Lifecycle Management {OId))
2 ICM (Incentive and Commission Management)
23 IM (Investment Management)
2= IN (International Development)
224 15 {Industry Specific)
2= KM (Knowledge Management)
4| LE (Logistics Execution)
324 Lo {Logistics - General)
=4 MM (Materials Management)

Search
Table Mame: Short Description:
application Component: Package:
Search
SAP Metadata

Cancel Reverse

ORACLE

Chapter 5
Reverse-Engineering the SAP Source Datastores

5-6



Chapter 5

Reverse-Engineering the SAP Source Datastores

5.2.4.1 The Tree View

The SAP Modules are organized into a tree view. Only the SAP Modules available to
the current user are displayed. By expanding the tree view, you can see SAP tables,

and select those that you want to reverse-engineer.

Note that only the tables selected in the tree view are reverse-engineered.

-—Eh S4P Metadata Browser

- ]

Search

Table Mame: Short Description:
[SADR3 = |

Application Component; Package:

Search

|y IO oy R oy Y oy OO oy O oy RSO oy IR oy A oy IO oy (RO oy IO g RO oy IO oy R oy O oy R oy O oy R oy Y oy OO oy IO oy Y oy N o

i SADR1Z (Address Management: Reserve table for communications numbers)
Sl SaDR 13 (Address Management; Reserve table For communications numbers)
i SaDR 14 (Address Management: Reserve table For communications numbers)
-] E SaDRZ (Address Management: Telephone Mumbers)

(] S8DR3 (Address Management: Fax Mumbers)

- {w] S8DR4 (Address Management: Teletext Mumbers)

- {w] SADRS (Address Management: Telex Mumbers)

-] SADRE {Address Management: EDI Table)

i SADRY (Address Management: Mail Fields)

Sl SADRE (Address management: &, 400 addresses)

i SaDRS (Address management: Soft*Switch numbers)

-] E SADRP (Address Management: Personal Data)

-] SaIM (Central Address File: Address where-used lisk)

[ ] L To0s (Countries)

-] TOOSA {Address routines)

-] TOOSE {Mame of address routines)

-] L To0sE (County

-] L To0SF (County: Texts)

(] TOOSM (Mame Formats)

-] [ tonso {Marme Farmat fields)

- [v] TO0S5 (Taxes: Reqgion (Province) Key)

k- [v] L TO0ST (Country Namnes)

-] TOOSU {Taxes: Region Key: Texts)

- ] Ei T3aZ (Communication Methods (Business Address Servicesiy |

Zancel Reverse

5.2.4.2 The Search Panel

The Search option group allows you search specific objects in the browser, based on:

ORACLE
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* Table Name

*  Short Description

*  Application Component
» Package

For the example project, the TO05T and TO05U country tables are used:

1. Enter TOO5T in the Table Name field and click Search to find the first table to
reverse-engineer. Select this table.

2. Enter TO05U in the Table Name field and click Search to find the second table to
reverse-engineer. Select this table.

3. Click Reverse.

4. Oracle Data Integrator starts the reverse-engineering process on the selected
datastores. The reverse-engineered datastores appear under the Model.

5.2.5 Reverse-Engineering Without GUI

ORACLE

If you want to perform a reverse-engineering without using the SAP Metadata Browser,
you can enter the following parameters in the SAP ERP KM options:

- USE_GUI: No
- SAP_TABLES_NAME : TO05T, T005U

With this configuration, the tables will be reverse-engineered without displaying the
SAP Metadata Browser.

By using the appropriate KM options, you can also select a filter for the reversed
tables based on for example a SAP Module or a Package name. You can also specify
a table name mask in the Mask field of the Reverse tab to filter table names.

Refer to the Application Adapters Guide for Oracle Data Integrator for more
information on the RKM options.

" Note:

It is not possible to view the data in the SAP ERP tables from Oracle Data
Integrator.

What happens when you reverse-engineer SAP ERP tables?

First, Oracle Data Integrator uploads in the SAP system ABAP code allowing for
retrieving the SAP metadata. This RFC is uploaded only if the UPLOAD_ABAP_CCDE

and UPLOAD_ABAP_BASE options are selected (these options are typically activated only
once). The ABAP programs are generated in the SAP function group given in the
SAP_FUNCTI ON_GROUP_ODI _DEV and SAP_FUNCTI ON_GROUP_QODI _PRCD RKM options.

Once this code is set up on SAP, Oracle Data Integrator is able to retrieve the

SAP metadata and to display it in the SAP Metadata Browser. Selected metadata

is then reverse-engineered from SAP into the Oracle Data Integrator repository. The
repository only contains the description of the SAP metadata, and no data at all.
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In addition to the table definitions organized and enriched with user-friendly
information, the keys and indexes definitions are also retrieved. The model appearing
in Oracle Data Integrator shows all the information required for performing integration
tasks on the SAP ERP Model.
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Creating and Running the Mapping

This chapter describes how to create and run the mapping.
This chapter includes the following sections.

6.1 Creating the Mapping

Now that the source and target data models are created, it is possible to create a
mapping to integrate data from the T0O05T and TO05U SAP tables to the W5_CGEO DS
Oracle table.

To create the mapping, perform the following steps:

6.1.1 Create the Mapping

Open Designer.

In the Projects tree view, expand the SAP Denp Project.
Expand the SDE_SAP_GeoDi nensi on folder.

Select the Mappings node.

Right-click and select New Mapping.

o o p W N PR

In the Mapping Definition tab, enter the mapping name:
SDE_SAP_GeoDi mensi on. W GEO DS.

7. Save the mapping.

6.1.2 Define the Source and Target Datastores

To define the source and target datastores:

* Inthe Models tree view, select the Ws_GEO DS datastore from the Oracl e Tar get
Model.

» Drag this datastore into the Target Datastore area of the Logical diagram. (Right

area of the Logical diagram)

* Inthe Models tree view, select the TOO5T Country Nanes datastore from the SAP

ERP Sour ce model.

» Drag this datastore into the Sour ces area of the Logical diagram.

e Perform the same operation for the TO05U Taxes: Regi on Key datastore from the
SAP ERP Sour ce model. The Sources area of the Logical diagram should look as

shown below:

ORACLE
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=] Default
L] L] L]
= T00ST ] T005U
@=  MANDT O MANDT
@= SPRAS O~ SPRAS
@=  LANDA T B LANDI 1
LAMDY (1o BLAND
MATIC BEZEI
LANDXS0 : ‘ ‘
MATIOS0
PRQ_SPREGT

6.1.3 Define Joins between Sources

To create joins between the source datastores of a mapping:

1. Inthe Sources area of the Logical diagram drag the SPRAS attribute from the
TOO5T Country Nane datastore onto the SPRAS attribute in the TO05U Taxes:
Regi on Key datastore.

2. On the Create Lookup or Join popup, select Join and click OK. This defines the
first join on the Language Key identifier, as shown below:

B Defautt
3] TOOST = TO05U
B=  MANDT G  MANDT
B= SPRAS B~  SPRAS
@  LANDT 57l @  LAND1
LAND¥ [ = @  BLAND
NATIO BEZEI
LAND¥50
NATIOSD
PRQ_SPREGT

3. Drag the LANDL attribute from the TOO5T Country Name datastore onto the LANDL
attribute in the TO05U Taxes: Regi on Key datastore. The join is extended
with the new attributes. In the Properties panel, you can see the join clause:
TOO5T. SPRAS=T005U. SPRAS AND TOO5T. LAND1=T005U. LAND1

4. Inthe Properties panel, select Generate ANSI Syntax and Join Order options,
and make sure that the Execute on Hint option is set to Source as shown below:
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JOIN - Properties
Q Firnd @
= Condition
Default.TO05T.SPRAS = Default.TO05U. SPRAS Default.TOO5T.LAHD1 = Default.TO005U.LAHD1
Join Condition:
Cross TMatural
TOOST(TOOST) E = TOOSU{TOOSUY
Join Type: 3
Innet Jain
&l rows paired by the join condition between TOOST{TOO0ST) and TOOSUTOOSLY

Technical Description: | |

Generate AMSI Synta:

Join Order: User Defined: |1El |

Execute on Hink: |Source '|

5. Make sure that table number of TO05U is smaller than that of TOO5T. In 1:n
relationships the parent table has to be the first in a join.

6.1.4 Create the Mappings

To create the mappings of the target datastore:

1. Select the LANGUAGE KEY attribute from the target datastore.

2. Drag the SPRAS attribute from the TOO5T Country Names source datastore onto the
LANGUAGE KEY attribute of the target datastore.

3. Make sure that the Execution on Hint option is set to Source. The mapping
should look as shown below:

New Mapping | BB LANGUAGE_KEY - Properties

Q, Find
[l Target
Default.TO05T.SPRAS
Expression:
Execute on Hink: |S|:|ur|:e '|
Fixed Execution Location: | v|

Technical Description: | |

4. Repeat this operation to perform the following simple mappings:
«  WGEO DS. COUNTRY = T0O5T. LANDL

e WGEQO DS. COUNTY = TOO5T. LANDX

«  W.GEO DS. STATE_PROV = T005U. BLAND

e WGEO DS. NATI ONALI TY = TOO5T. NATI O

ORACLE 6-3



Chapter 6
Running the Mapping

6.1.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Physical diagram looks as shown below;

"1, SOURCE_GROUP

< | OGICAL_SAP_ERP_UNIT
77 TARGET_GROUP

EH
] @® ODI_SAP_DEMO_UNIT
TOOST
5 3 B
> AGED DS
et DEFAULT.. Kot
=
TOOSU

2. In the target group, select the access point for the source group that contains both
the TOO5T and TOO5U datastores. This source group represents the source dataset
made up of two joined SAP ERP datastores.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP ERP to
Oracle (SQLLDR) or LKM SAP ERP to SQ from the Loading Knowledge Module
drop-down list.

a. Ifyou are using FTP for the data transfer, please set the
FTP_TRANSFER_METHOD option to FTP. If the FTP server is installed on
your ODI agent machine, select NONE.

b. Leave other options as they are.

4. In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. In Property panel, under Integration Knowledge Module, select | KM Oracl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

6. Setthe IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

7. From the File menu, click Save and close your mapping.

6.2 Running the Mapping

This section contains the following topics.
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6.2.1 Running the Mapping

To run the mapping:

1. Inthe Projects tree view, expand the SAP Deno Project
2. Expand the SDE_SAP_GeoDi nensi on folder.

3. Expand the Mappings node.

4. Select the SDE_SAP_GeoDi nensi on. W GEO_DS mapping.
5. Right-click and select Execute.

6. In the Execution window that appears, click OK.

7

Click OK in the Session Started window.

What happens when you run the mapping?
First, Oracle Data Integrator creates an ABAP program that does the following:

e It performs the extraction of the data on the SAP engine. In this example, the
extraction joins the two source tables and then returns the joined resultset in an
extraction file.

» It uploads the extraction file into a FTP data server. This FTP host is specified via
the File Logical Schema called Fi | e Server for SAP ABAP. This Logical Schema
is mapped to a Physical Schema and therefore a data server in the given context.
This data server contains the connection information for the FTP host.

Then, the ABAP code is uploaded using the OdiSapAbapExecute tool. The ABAP
program is pushed into the SAP Function group given in the SAP_FUNCTI ON_GROUP LKM
option. This phase can be suppressed by setting the UPLOAD ABAP_CCODE LKM option to
No.

The ABAP code is executed also by the OdiSapAbapExecute tool. At the end of the
ABAP code execution, the extraction file is available in the FTP host.

The Oracle Data Integrator agent is able to download this extraction file from the FTP
host, or directly access it, depending on the FTP_TRANSFER_METHOD specified in
the IKM option.

Finally, when the agent accesses the extraction file, it uses SQL*Loader or a JDBC
Connection to load this file into the Oracle/non-Oracle staging area. The rest of the
integration process takes place within the Oracle/non-Oracle engine.

6.2.2 Review the Mapping Execution

ORACLE

To review the mapping execution:

Connect to Operator.

In the Operator, select the Session List tree view.
Expand the All Executions node in this tree view.
The latest session is the first entry of this list.

Double click the SDE_SAP_GeoDi nensi on. W GEO_DS node to see the session details
and the number of lines processed.

g H @ b P
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6.2.3 Review the Resulting Data

To review the resulting data:

1. Inthe Designer, in the Models tree view, expand the Oracl e Target Model.

2. Select the W GEO DS datastore, right-click and select Data to view the data
integrated into the target Oracle table.
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Using Advanced Join Handling for Change
Detection with SAP CDHDR Table

The SAP system table CDHDR holds information about data changes in SAP business
tables like MARA. Among other data this includes the (concatenated) business key (field
CDHDR. OBJECTI D), change type and change timestamp (field CDHDR. UDATE and UTI ME).

In this example the business key is the material number ( MARA. MATNR) . Starting with
v42 the ODI SAP adapter for SAP ERP/ECC supports substring operations in join
conditions. This chapter gives an example of how to use a complex join expression
between the SAP tables MARA and CDHDR to extract only new/modified/deleted MARA
records.

In case of MARA you can identify relevant changes with the help of CDHDR by applying
these filter/join conditions:

e record type filter on CDHDR: CDHDR. OBJECTCLASS = ' MATERI AL'

e time filter on CDHDR: the timestamp ( CDHDR. UDATE, CDHDR. UTI ME) is greater than
the last extraction timestamp and smaller than the current timestamp

e join condition: the first 18 characters of CDHDR. OBJECTI D match MARA. MATNR

" Note:

For other object classes and their object id composition/ business key,
contact your SAP team.

The following sections cover all the steps needed for building an ODI scenario for delta
extraction: on every execution the package extracts any MARA changes since last run
and applies the changes to the Oracle target table.

*  Setting Up Required Tools and Versions

» Creating Variables

»  Creating Mapping with Advanced Join Condition

* Using Filters Condition in Mapping

» Creating a Package for Extracting Updated Records
* Understanding Last Extract Timestamp Parameter

* Running the Package

7.1 Required Tools and Versions

This section lists the required tools and their versions.

1. ODI Version — Oracle Data Integrator Version 12.2.1
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2. Open Tool Version — Oracle SAP Connector Version 10.1.3.23
3. JCo version

a. JCo APl —3.0.17 (2017 —07-17)

b. JCo Middleware — JavaRfc 2.2.20

c. JCo Library — 721.913

d. Path to JCo Archive —
c:\Oracle\Middleware\Oracle_Home1\odi\sdk\lib\sapjco3.jar

e. Pathto JCo Library —
c:\Oracle\Middleware\Oracle_Home1\odi\sdk\lib\sapjco3.dll

4. SAP KMs Build Number - 42
5. IKM - IKM Oracle Incremental Update

7.2 Creating Variables

This section describes all the ODI variables used in the below example. Through these
variables you can save and get the value of last extract timestamp. Please create all
the variables as specified below:

1. LAST_EXTR_TS — This variable contains the value for Last Extract Timestamp.
Its default value is 00000000:000000 which is required for first attempt and it
keeps the latest value in history as shown below:

2) Start Page | ¥ LAST_EXTR_TS

Definition

Refreshing ¥ Vvariable [Project: SAP]
History Marne: |LF'.ST_E><TR_TS
TSRS Datatype: | Alphanumeric
Mmoo

Yersion Keep History: |Latest Yalue
Privileges Secure Yalue: []

Default Yalue: |Dnnnnnnn:nnnnnn

Description:

2. LAST_EXTR_DATE — This variable contains Last Extract Date which takes its
value from the Last Extracted Timestamp parameter. The refresh expression
shown below is used to update the variable:
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2)StartPage | LAST_EXTR_DATE

Drefinition

Schema: | Cracle_LG - |

Refreshing

Hiskory Select Query: EEI L4 /

Markers select SUBSTR('#34P.LAST_EXTR_TS',1,8) from dual
Memo

Version

Privileges

LAST_EXTR_TIME — This variable contains Last Extract Time which takes its
value from Last Extracted Timestamp parameter.

(2) StartPage . f/ LAST_ERTR_DATE ¥ LAST_EXTR_TIME

Definikion
Refreshing Schema: | COracle_LG - |

Hiskory Select Query: @ﬂ "4 /

Markers select SUBSTR{#SAP.LAST_ExTR_TS',10,6% from dual
Memo

Mersion

Privileges
CURR_TS— This variable contains the Current Timestamp. The refresh

expression shown below is used to update the variable:

(2) StartPage | ¥ CURR_TS

Definition

Schema: | Cracle_LG -

Refreshing

History Select Query: EEI & /

Markers select TO_CHAR(CURRENT _TIMESTAMP, " YMMDD HHZ4MISS" From dual
Memo

Version

Privileges

CURR_DATE— This variable contains Current Date which takes its value from
CURR_TSparameter. The refresh expression shown in the below image is used to
update the variable:
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(2) StartPage ¢ CURR_TS % CURR_DATE

Definition

Refreshing schema: | Oracle_Lia - |

Hiskary Select Query: @ﬂ "4 /

Markers select SUBSTR( #34P . CURR_TS', 1,3) from dual
Merno

Version

Privileqes

CURR_TIME — This variable contains Current Time which takes its value from
CURR_TSparameter. The refresh expression shown below is used to update the
variable:

(2) StartPage @ CURR_TIME

Definition

Refreshing Schema: | Oracle_La - |

Hisktory Select Query: E}ﬂ L4 /

Marker s select SUBSTR{'#34P . CURR_TS', 10,6) From dual
Memo

Version

Privileges

7.3 Creating Mapping with Advanced Join Condition

ORACLE

Create a simple mapping where you can join two tables as CDHDR and MARA based on
below condition and use two filters to extract the data from SAP and store in target
oracle table named MARA REPLI| CATED.

1.

Join Condition
Join OBJECTI Dof CDHDRfrom index zero to 18 with MATNR of MARA.

CDHDR. CBJECTI D+0( 18) = MARA. MATAR

Mapped fields from Source to Target

In this mapping, you can map (by drag and drop) the following fields from source
(MARA and CDHDR) to target ( MARA REPLI CATED) .

MARA. MANDT -> MARA_REPLI CATED. MANDT

MARA. MATNR -> MARA REPLI CATED. MATNR

MARA. LVORM - > MARA REPLI CATED. DELETED

MARA. MEINS -> MARA REPLI| CATED. MEI NS

CDHDR. OBJECTI D -> MARA_REPLI CATED. CDHDR_OBJECTI D
CDHDR. UDATE -> MARA_REPLI CATED. UDATE

CDHDR. TCODE -> MARA_REPLI CATED. TCODE
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. coror_cemo_oHz | [37] coHoR_pEMo_oHz

& & wen ~ ||TEHME &

= CDHDR
G~  MAMDANT
@~  OBJECTCLAS =
@~  OBJECTID L
G~ CHANGENR
USERNAME
UDATE »|
UTIME L [F]  marA_REPLICATED
TCODE | w @=  MANDT
PLANCHMGNR o E= MATNR
ACT_CHMGNO - ERSDA
, I ERNAM
= P LAEDA
/JoIN AENAM
] TR FILTER FILTER1 =
E=  MANDT ] PSTAT
@ MATNR [~ o DELETED
ERSDA MTART
ERNAM
LAEDA J
AENAM
VPSTA
PSTAT
LYORM o
MTART

() startPage | T 10IM- Properties - | COHOR_DEMO | F LAST_EXTR_TS Session COHDR_DEMO (8303 [JE] COHDR_MARA_IOT
o Q Find

=] Condition

CDHDE.. 0OBJECTID+0(15) = MARA.MATHR
Join Condition:

Cross Matural
COHDR{CDHDR) O O MARA(MARA)

Join Type:
b Left Quker Join

All rows of COHDR{CDHDR ) including the rows unpaired with MARA{MARA) rows

Technical Description; |[CDHDR Change document header (COHDR )], [Object walue]+0{18) = [MARA General Makerial Data (MAaRA) ] [Material Mumber]

7.4 Using Filters Condition in Mapping

You can use filter conditions to select the related data change log entries. Listed below
are two filters — OBJECTCLAS of CDHDRand the next filter is using few variables related
to date and time as mentioned above for extracting updated records.

*  Filter 1 contains below condition:

CDHDR. OBJECTCLAS = ' MATERI AL’
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() StartPage | TP FILTER - Properties  f CURR_TIME 7 COWDR_DEMD (] COHDR_MARA_JOIN.Z bd
o Q Find @ f
= Condition
CDHDR.. 0BJECTCLAS = 'MATERIAL'
Filter Condtion:
Techrical Description: [COADR_Change document header (CDHOR)].[Cbject dass] = MATERIAL |
Exeuts onHint: | o Hint -]
= General
Mame: [FrLTer | L
Description: [ |
Active:
Component Type: [FILTER |
= Connector Points
<] 1nput Connectar Points  [F* Output Connector Points
Tnpuk Cannector Points: Q + X E-
Mame: Description Bound Objsct Cornected From
NPUTL [2om =]
Filter 2 contains below condition:
Based on this condition you can retrieve only updated records which is not
extracted yet.
(CDHDR UDATE > #SAP. LAST EXTR DATE OR ((CDHDR. UDATE =
#SAP. LAST EXTR DATE AND CDHDR UTI ME > #SAP. LAST EXTR TI ME)) AND
( CDHDR. UDATE < #SAP. CURR DATE OR ( CDHDR. UDATE = #SAP. CURR DATE
AND
CDHDR UTI ME <= #SAP. CURR T ME))
() StartPage | T FILTERI - Properties | CURR_TIME 0 COHDR_DEMO  [Jf] COHDR_MARA_JOIN_2 bd
o Q Find @k
= Condition

Filter Condition:

(CDHDR.UDATE > HSAP.LAST EXTR DATE
(CDHDR.UDATE < HSAP.CURR DATE

(CDHDR.UDRTE = HSAP.LAST FXTR DATE
(CDHDR.UDATE = {SAP.CURR DATE

CDHDR.UTIME <= {SAP.CURR TTME) )

CDHDR.UTIME > HSAP.LAST FXTR TIME])

Technics| Description: [sder (COHDR)].[Creation date of the change document] = [5AP.CURR_DATE] AND [COHDR Change dacument header (COHDR).[Time changed] <= [5AP.CURR_TIME]))]

Exeuts onHint: | o Hint
= General

Mame: ‘FILTERl

Description: [

Active:

Component Type: [FILTER

= Connector Points
=] nput Connectar Points
Input Connector Paints:

Marme:
THPUTL

[F* output Connector Points

Description

Bound Object

Q + X @8-

Connected From
|FILTER -

m
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7.5 Creating a Package for Extracting Updated Records

Create a package by following the instructions given below which contains few Date
and Time range ODI variables and also create a mapping as described above:

3 coHOR_DEMo_oHz [T CDHDR_DEMO_OHZ

REEw = et @ r 88 A

Toolex

= al
odiant 5 o
Al

= dg—— 7=

» Ty

[y odinpplyDeploymentarchive
2 od LASTiExT{TS LAST_EXTR_DATE LAST_EXTR_TIME
iBeep

[ odicreateDeployment Archive
Eg; odiDeletescen

B3 odiEnterpriseDataduality

¥ odiExportallscen

¥ OdiExportEnvironmentInfarmati
=¥ OdiExpartLog

% odiExportMaster

3y odiexportChiect

E%¥ OdiExpartSeen

~ Ty -y

CURR_TS CURR_DATE CURR_TIME  CPHDR_DEMO_OH2 | oy pyrp 1g

There are eight steps in creating the package (termed as Steps Hierarchy) as shown

below:
Blueprint # Steps Hierarchy Step Type
- = B CDHDR_DEMO
Privileges =
] ':' LAST_ExTR_Ta Declare Yariable
1 ﬁ LAST_EXTR_DATE Refresh Variable
z E | LAST_EXTR_TIME Refresh Yariable
3 B CURR_TS Refresh variable
4 E- {f CURR_DATE Refresh Yariable
5 G CURR_TIME Refresh variable
& E {f COHDR_MARA_JOIN_2 Mapping
7 G- LAST_EXTR_TS Set Wariable
Set Variable: Set the value for LAST_EXTR_TS variable as shown below:
‘ Properties
General  Advanced  Memo  Wersion | Privileges
Step name Type
[LasT_ExrR_TS | (setvariable |
Linked object Path
[LasT_ExTR T3 EE |
(3) Assign
value

|#SAP.CURR_TS

7.6 Understanding Last Extract Timestamp Parameter

Before extracting the records, you have to check Last Extract Timestamp parameter so
that you can know the exact time when the records were extracted. Default value of

ORACLE"
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Last Extract Timestamp is 00000000:000000 and after first execution it picks its value
from History.

(2) Start Page 4 COHDR_DEMO ¥ LAST_EXTR_TS Session COHDR,_DEMO (830)

Definition c@ able .

Refreshing | Variable [Project: SAP]
Histary Name: LAST_EXTR_T3
Marke

Arkers Dakatype: |P.I|:uhanumeriu:
Merno

Varsion keep Histary: |Latest Walue
Privieges Secure Yalue: [

Default Yalue: |DEIEIEIDEIEIEI:DDEIEIDD

Description:

7.7 Running the Package

By using Join function with CDHDR table there are various execution processes to
extract record from SAP and store in Oracle database. Here we are using V42 SAP
KMs with Incremental IKM.

»  Execute Scenario to Extract all the Updated Records
» Create New Records in SAP table and Execute Package to Extract New Records
» Update Records in SAP and Execute the package to Extract Updated Records

» Delete Records from SAP and Execute Package
7.7.1 Execute Scenario to Extract all the Updated Records

In the IKM, set theCr eat e_Tar get _Tabl e option to Tr ue, as you are retrieving records
for the first time, as given below:

* Modify the Mapping flow

&) MarA_REPLICATED - Properties || COHER.DEMO 02 ~
s Q Find @
= General

Attributes

= Integration Knowledge Module

Integration Knowledge Module: | TKM Oracle Incremental Update -

Style: ‘Template-sty\e ‘

Options  Desription

Options: BH-HH
Warme Descriptian Help  value Use Default
INSERT Insert new rows G True
~\JPDATE Update target table € True
COMMIT Post Integration Commit @ True
-+ SVNC_JRN_DELETE Synchronise Journalized deletions ¢ True
FLOW_CONTROL isctivate Flow control ¢ False 0
RECYCLE_FRRORS Recycle previous erors @ False |
-+ STATIC_CONTROL Post Integration Control ¢ False 7
TRUNCATE Truncate the target table @ False
- DELETE_ALL Delete &ll rows € False
CREATE_TARG_TABLE Create the target table _-:-
DELETE_TEMPORARY_OBJECTS Delete temp objects post int. G Trug
FLOW_TABLE_OFTIONS Option for Flow table creation ( 0
CREATE_FLOW_INDEX Create index on Flow table @ False 0
-+ COMPATIBLE RDBMS version of stagingitarget ¢ 9
VALIDATE Validate KM options ¢ False
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Execute Package — Now execute the package to extract all the records which
are updated until specific date. When you are executing the package for the first
time, it picks its default value from Last Extract Timestamp parameter.

3 COHDR_DEMO_OHZ

NEESENSEE EECAL TSR

Toolbax

(=]

[ oditpplyDeployment Archive
1 Odigeep

[ odiCreateDeploymentarchive
B odiDeleteScen

B odinterpriseDataCuality
¥ odiExportAllscen

y odiExpartEnwironmentInformatic
=¥ odiExpartLog

5% OdiExportMaster

¥ odiExportobject

=¥ OdiExportScen

(= Changed Data Capture:

(= Event Detection

(= Files

(= Internet

(= Metadata

(= Oradle Data Integrator Objects
(= Plugins

J
s ST s ST S el P - =
T o Uy Uy Uy Yy DQ—V —7_
msT_ExT?_Ts LAST_EXTR_DATE LAST_EXTR_TIME CURR_TS CURR_DATE CURR_TIME CDHDR_DEMO_OHZ  LAST_EXTR_TS
Run
Context: [Fre
Logical Agent: |Local (Mo Agent)
LogLevel:
[ Simulation
Help oK Cancel
Properties
General | Advanced | Memo | Version | Privileges
Step name Type
|coHDR_pEMO_oHz | [Fiow (Mapping) =/
Linked object path
[coHDR_pEMO_oHz | [54P].[First Folder]|

Bhusieal Mannina Nacian

Check Extracted Records — Upon successful execution of the Package, related
records are inserted to the Oracle Target Database.

foner Operator

7@ s

sssion List
B Al £xe

880

872
71
870
869-
892
891~
863 -
867
890-
866 -
889~
883 -
887 -
886 -
885 -
884 -
883-
882~
881 -

e

OHZz _CDHDR_DEMO - Dec.
CDHDR_DEMO_OH2 - Mo
CDHDR_DEMO_OHZ - Nov
CDHDR_DEMO_OHZ - Hov
GHz_CDHDR_MARA_IOIN
USROZMapping_Physical S
GHRSRC - Nov 5, 2018 410
GHz_CDHDR_DEMO - Nov

OH2 _CDHDR_PMARA_IOIN

GHz_CDHDR_DEMO - Cet

Hz_COHDR_MARA_IOIN
GH2_COHDR_MARA_IOIN
GHz_COHDR_MARA_IOIN
CDHDR _OH2_Physical_SE¢
©H2_CDHDR_MARA_ICIN
Hz_COHDR_MARA_IOIN
CDHDR_OH2_Physical_SE¢
GHz_COHDR_MARA_IOIN
GH2_COHDR_MARA_IOIN

- GHz_CDHDR_MARA_JOIN
879
78

OH2_CDHDR_PMARA_IOIN

OH2 _CDHDR_PMARA_IOIN

erarchical Sessions

12d Plan Execuions

= COHDR_DEMO_OHz.

O Qe [
Definition
Steps E fon
Blueprint Instance ID: [e72 Global 10: |efbszdsc 5530-4979-bacF-1d164asitash
PAIEOES | Secsonniame; [COHOR_DEMO_OHZ Status: [pone =
Scenaro Mame: | Contexts [re

Session COHDR_DEMO_CHZ (373)

Scenarlo Yersion: |

Physical Agent: |Local (No Agent]

Start: [pec3, 2018325016 P

End: [pecs, 2018 32525 o1t

[S———

m

Retumcode: 0

Restart Type:
URL:

E Concurrent Execution Controller

Violation Behavior

Wat Foling Interval

ERecord

nigfaf Rows:

Byof Updates: [0 |

No. of Deletes: 0|

Seconds

Extracted Records — Find the extracted records in target database as show
below:
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z
4 p SELECT MANDT,MATNR, UDATE, TCODE,DELETED,MEINS FROM MARZ REPLICATED ORDER BY UDATE DESC
=

[ 1
Data Grid
L.'_::h Messages Data Grid | [ Trace |[1_‘? DBMS Qutput (disabled) |D Query Viewer |E Explain Plan mﬂ Script Qutput
|BE|<<p pd=avx| -

= MANDT | MATNR UDATE TCODE DELETED| MEINS

b (810 000000000000000038 11/19/2018 MMO1 X G
810 000000000000000037 11/19/2018 MMO1 X o
810 000000000000000039 11/19/2018 MMO1 CCM
810 000000000000000036 11/5/2018 MMO1 X KAR
810 000000000000000035 11/5/2018 MMO1 X CCM
810 000000000000000031 10/29/2018 MMO1 o
810 000000000000000034 10/29/2018 MMO1 G
810 000000000000000033 10/29/2018 MMO1 HL
810 000000000000000032 10/29/2018 MMO1 GAU
810 000000000000000023 7/30/2018 MMO1 5T
810 000000000000000022 7/26/2018 MMO1 5T
ain nnpnonoanononnonnnzi FHama MMM |T

5 S T T

4 22 [720msecs  |Row lof 500 fetched so far (more rows exist)  |DEV42REPO@10.30.32.71:1521/PDBORCL m |Windows (CRLF)

7.7.2 Create New Records in SAP table and Execute Package to
Extract New Records

To create new records in SAP table:

1. Create a new material as shown below:

Select View(s) Org. Levels Data
Material | |@|
Industry sector Mechanical enginee..w
Material Type Finished product v

Change Number

Copy from...

Material 000000000000000033

& Material 000000000000000041 created

2. Modify the Mapping Flow
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Post Integration Cortral,

T E

DELETE_ALL
CREATE_TARG_TAELE
DELETE_TEMPORARY_OBJECTS
FLOW_TABLE_OPTIONS
CREATE_FLOW_INDE
COMPATIBLE

VALIDATE

Delete al rows

Create the targst table

Delste temp objects post int.
Option for Flow table creation
Create index on flow table
RDEMS version of staging/target

Validate KM options

4
General
Attributes
=l Integration Knowledge Module
Inkegration Knawledge Module: |Teh Oracle Incramentsl Lipdate
Style: ‘Temp\ate-slyle
Optians | Description
Options: B-uE
Hame Description Help  valus Use Default
TNSERT Insert new rows True
UPDATE Update target table & True
COMMIT Fost Integration Commit G True
SYNC_IRN_DELETE Synchrarise: Journalized deletions G True
FLOW_CONTROL Activate Flow control G False
RECYCLE_ERRORS Recycle previous errors False
STATIC_CONTROL False

!HDDHDHIHHDH!

Check the value for last extracted Timestamp in the History tag of LAST_EXTR TS

parameter.

1] COHDR_DEMO OHz 7 LAST_EXTR_TS

Definition —

Refroshing | COTHeXEFiter ‘Miv

History wales:

Markers Date walug

Memo Dec 3, 2018 3:25:25PM 20181203 152516
Yersion

Privileges

Context
FTP

@ X

Execute the Package - After creating a new material in the SAP table execute the
package again. When the Package gets executed successfully, one new record is

inserted in the Oracle Target Database.

4 COHDR_DEMO_OH2 Session COHDR_DEMO_DH? (894)

O-0 s sH
Definition _
e Session
Elueprint Instance I0; ‘594 Global ID: |EE193€(€—9EEE'4Ed3'h954724t73236536f
FIVIEOSS  Secsoneme:  [CDHDR_DEMO_GHE Status: [ene -
ScerarioName: | Context: [Fre

Seenario Version: ‘

Stark: ‘Dec 3, 2018 4:26:03 PM

Duration (seconds): 3

Restart Type:
URL:

ElConcurrent Execution Controller

wiclation Behavior:

Wait Poling Interval:

‘ord Statistics

Mol of Lipdates: D

Ho, of Deletes: [1 |

h. of Rows:

Error esso

Physical Agent: |Ln[a\ (Mo Agent)

End: |Dec 3, 2018 4:28:12 PM

mn

Retum Code: [0

Seconds

Extracted Records- The top most records in the below table is the new record

which is inserted post package execution.
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sul (recovered) = +

2
4 p  SELECT MANDT,MATNR,UDATE, TCODE, DELETED,MEINS FROM MARA REFLICATED ORDER BY UDATE DESC
=

4 i
Data Grid
L.;‘h Messages Datz Grid | [ Trace |[1_‘1_] DEMS Output (disabled) |D Query Viewer |§ Explain Flan mﬂ Script Output
BB <ap b =av x| -
=| MANDT| MATHR |UDATE |TcopE | DELETED|MEINS
EY 810 | 000000000000000041 12/3/2018 MMO1 G
810  |000000000000000039 11/19/2018 MMO1 ccM
810  |000000000000000038 11/19/2018 MMO1 X G
810  |000000000000000037 11/19/2018 MMO1 X %
810  |000000000000000036 11/5/2018 MMO1 X KAR
810  |000000000000000035 11/5/2018 MMO1 X cCcM
810  |000000000000000031 10/29/2018 MMO1 %
810  |000000000000000034 10/29/2018 MMO1 G
810  |000000000000000033 10/29/2018 MMO1 HL
810  |000000000000000032 10/29/2018 MMO1 GAU
810  |000000000000000023 7/30/2018 MMO1 sT
aln nnpnnnonnonNnannng ? TR A MO ST
B 5 T I
| 48 [4secs  |Row 1of500 fetched so far (morerows exist)  |DEV42REPO@10.30.32.71:1521/PDBORCL | EBM |Windows (CRLF)  |Modified

7.7.3 Update Records in SAP and Execute the package to Extract
Updated Records

From the above image, the value of column MEINS for material 33 and 41 is as HL
and G respectively. Now you can update the MEINS column value for these records as
shown below:

1. Update the value for these two records in SAP for material number 41 and 33 as
shown below:

Figure 7-1 For Material 33

Change Material (Initial Screen)

Select View(s) Org. Levels Data

Material loooooooooooo000033|])

Change Mumber

& Material 000000000000000033 changed
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Figure 7-2 For Material 41

Change Material (Initial Screen)

Select View(s) Org. Levels Data

Material 1000000000000000041 :T;

Change Mumber

& Material 000000000000000041 changed

2. Check the last extracted Timestamp from the History tag of the parameter
LAST_EXTR TS.

. COHDR_DEMO_OHZ | & LAST_EXTR_TS

Definition

Refreshing Context Filker: |.0.II -

History Values: Elﬂ %
Markers Date Yalue Conkext

Merno Dec 3, 2018 4:28:13 PM 20181203 162803 FTP

Yersion

Privieges

3. Execute Package - After updating materials in SAP table execute the package

again.

4. Package is executed successfully and two records are updated in Oracle Target

Database. Its record statistics is displayed as shown below:

1 CDHDR_DEMO_OHZ Session COHDR_DEMO_OH2 (595)

|

O O Rl 5

Definition _
Session

Steps

Blueptint Instance I0; ‘595 Global ID: ‘haaf?dﬂﬁ'1343'4d57'995d'923EDZEEEIEE

Privils

RO Gevsonbames  COHOR_DEMG 02 Seatus: [pone =
Scenario Name: | Context: [Fre

Start: ‘DEE 3, 2018 448112 PM End: ‘DE( 3, 2018 4:48:20 PM

I

| |
| \
| |
Scenario version: | | physical dgent: [Local (o Agent) |
| |
| |

Duration (secands); 8 RetunCode: 0

Restart Type:
URL:

[/Concurrent Execution Controller

Wiolation Behavior:

Wait Poling Inkerval: Seconds

[ZIRecard Statistics

Mo, of Inserts: D No. of Updates: M of Deletes: D
MoofEmors: [0 | N ofRows B |

Error Message:
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5. Extracted Records - Below highlighted records are updated in the target database
after package execution.

st (recovered) = @] +

n bW

> SELECT MANDT, MATNR, UDATE, TCODE, DELETED, MEINS FROM MALRA REFLICATED ORDER BY UDATE DESC

4 LI}

% Messages Data Grid | B Trace |[1_‘? DBMS Qutput (disabled) |D Query Viewer |§ Explain Plan ‘E Script Output

IBB|(e<r bt =avx|liz-

=|MANDT MATNR |uDATE 'TCODE | DELETED MEINS

. 000000000000000033 12/3/2018 MMD2

» 000000000000000041 12/3/2018 MMD2
810 000000000000000039 11/19/2018 MMO1 ccMm
810 000000000000000038 11/19/2018 MMO1 X G
810  000000000000000037 11/19/2018 MMO1 X %
810  000000000000000036 11/5/2018 MMO1 X KAR
810  000000000000000035 11/5/2018 MMO1 X ccm
810  000000000000000031 10/29/2018 MMO1 %
810  000000000000000034 10/29/2018 MMO1 G
810  000000000000000032 10/29/2018 MMO1 GAU
810  000000000000000023 7/30/2018 MMO1 sT

|«| :‘Iln»l " ﬂ‘nFEFIIHAﬂIFIETS( rl:r;:l?*lgl 7f7ﬁf7ﬂﬂ MMN1 |T

4 8  [837msecs  |Row 2of 500 fetched so far (morerows exist) | DEV4ZREPO@10.30.32.71:1521PDBORCL | BB Windows (CRLF)  |Modified |

7.7.4 Delete Records from SAP and Execute Package

For deleting records from SAP table:

1. From the below MADescripRA_REPLICATED Target table find the highlighted
details before the flagging material for deletion.

Bﬂ (recovered) = [@| +

oW N

2 SELECT MANWDT,MATHR,UDATE, TCCDE, DELETED,MEINS FRCM MARA REFLICATED ORDER BY UDATE DESC

4 Lk

% Messages Data Grid Trace |[1_‘? DBMS Output (disabled) |D Query Viewer |E Explain Plan |% Script Output

BB ar bt =avx|[u3-

= MANDT| MATNR UDATE TCODE | DELETED| MEMS
810 |000000000000000033 12/3/2018 MM02 K1
810 |000000000000000041 12/3/2018 MM02 PAK
810 |00000000000000003S 11/19/2018  |MMO1 cem
810 |D0000D000000000003S 11/19/2018  |MMOI X G
810 |D0000D0000000000037 11/19/2018  |MMOI X %
810 |D0000D000D0000003G 11/5/2018 MMOL X KAR
810 |D0000D000000000003S 11/5/2018 MMOL X

000000000000000031 MMO1

000000000000000034

10/29/2018
10/29/2018

Material 31 and 34
before the Deletion

810 000000000000000032 10/29/2018 MMO1 GAU

810 000000000000000023 7/30/2018 MMO1 ST

810 000000000000000022 7/26/2018 MMO1 ST
0 3 I I R T el o]

[ 21 [336msecs  [Row8of 500 fetched so far (more rows exist)  [DEV42REPO@10.30.32.71:1521/PDEORCL | |Windows (CRLF)  [Modified

CAPS |NUM | INS
[coes [rum s |

Material 31 and 34 are marked for deletion. Field LVORM (DF at client level)
will be empty before deletion in the MARA Table which we mapped with field
DELETED in Target table.

2. CDHDR table adds a new row for all the new material created, updated and
flagged for deletion.
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Data Browser: Table CDHDR Select Entries 6
0§ = E. 9 [[ CheckTabe..
1umns: [a]  rist wiawn oz2s0

MANDANT [OBIECTCIAS OBJECTIE CHMNGENR |USERNAME | UDATE UTIME | TCODE
810  |MATERIAL 000000000000000051 0000014514 | ZODI_RKMTEST| 03.12.2018[16:52:

810  |MATERTAL 000000000000000034 0000014515 | ZODI_RKMTEST| 03.12.201816

810  |MATERIAL 000000000000000041 0000014505 T10670 03.12.2018

810  |MATERTAL 000000000000000041 0000014510 | ZODI_RRMTEST| 03.12.2018

810  |MATERIAL 000000000000000041 0000014511 | ZODI_RRMTEST| 03.12.2018

810  |MATERIAL 000000000000000041 0000014513 | ZODI_RKMTEST| 03.12.20181¢

TCode fi el d holds the below values:
a. MMO1: New material created
b. MMO2: Existing material updated

c. MMO6: Material marked for deletion

3. MARA Table - If a material is marked for deletion a new row is added with Tcode :
MW6 (Del etion). After flagging material for deletion Field LVORM (DF at client

level) is updated with ‘X’.

Data Browser: Table MARA Select Entries 3
T KM AP =FEEBED

[7] Check Table...

5

237 Fizxed Columns: IL 2, List Widch 0250
MANDT | MATHR ERSLR ERNAM LLEDR BENIM VESTA BSTAT LVORM| MTART |MBRSH
810 000000000000000031 29.10.2018|I10670 03.12.201%|Z0DI_REMIEST|K K X EMAT C
810 000000000000000033 29.10.2018|I10670 03.12.201%|Z0DI_REMIEST|K K FERT |M
810 000000000000000041 03.12.2018|110670 03.12.2018|ZODI_REMTEST|K K FERT M

4. Execute package - Package execute success as find below instance there are two

records are changed.

.3 COHDR_DEMO_OHZ Session CDHDR_DEMO_OHZ (896)

O wa =5

Definition _
Session
Steps
Busprint  Instance1D: pss GlobalID:  [43b0B0SE-GTE-d544-00TE-b7 3T A09905
Privi
BAEEED Session Name: |coror_pemo_orz Status: |pane -
Scenario Name: | Context: Fre

Scenario ersion: |

Start: ‘DEE 3, 2018 5:54:12 P

Duration (seconds); [10

Restart Type:

URL:

[Z/Concurrent Execution Controller

Wiclation Behavior:

ait Poling Interval:

[=Record Statistics

N

Error Message:

€. of Updates:

0. of Deletes: [0 |

jo. of Rows:

Physical Agent: \anal (Mo Agent)

End: ‘DEE 3, 2018 5:54:22 PM

.

Retum Code: |0

Seconds

5. Extracted Records - After package execution find the extracted records in target

oracle table MARA_REPLICATED as below.
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wh (recovered) = B | +

2
3 p SELECT MANDT,MATNR,UDATE,TCODE, DELETED,MEINS FROM MARA REPLICATED ORDER BY UDATE| DESC

= i

|Data Grid

% Messages Data Grid \% Trace |[1_‘? DBEMS Qutput {disabled) |D Query Viewer |E Explain Plan |E Script Qutput

Bl apr b =avx| -

MANDT | MATNR UDATE TCODE DELETED| MEINS

k |B10 000000000000000041 12/3/2018 MMOZ PAK
810 |000000000000000034 12/3/2018 MMOE X G 3 pfter flagging material for delation
810  |000000000000000033 12/3/2018 MMO2 KI Field DELETED (DF at client level)
810 |000000000000000031 12/3/2018 MMOG X % ¢ will be updated with ‘X', As it is
810  |000000000000000039 11/19/2018 MMOL ccM mapped with LVORM Field.
810 000000000000000038 11/19/2018 MMO1 X G
810 000000000000000037 11/19/2018 MMO1 X Yo
810 000000000000000035 11/5/2018 MMO1 X CCM
810 000000000000000036 11/5/2018 MMO1 X KAR
810 000000000000000032 10/29/2018 MMO1 GAU
810 000000000000000023 7/30/2018 MMO1 sT
810 000000000000000022 7/26/2018 MMO1 sT
210 |D0POOONANNOANONNZ T FHRMA MM ST

R 3 o S P T

386  [843msecs  |Row 1of 500 fetched so far (morerows exist)  |DEV4ZREPO@10.30.32.71:1521PDBORCL | BB |Windows (CRLF)  |Modified |

ceps [ (105 [Run to curser

ORACLE"
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Going Further with Oracle Data Integrator

This chapter describes what steps to take next with Oracle Data Integrator.
You have now completed a project extracting data from a SAP ERP system!

In this project, you have:

e Set up the environment and topology to work with SAP ERP.
* Created and reverse-engineered a SAP ERP data model

* Created a mapping to load the data from several joined SAP ERP tables into the
Oracle database.

< Note:

In case the execution did not complete successfully, please check the
ODI Operator and ODI Logs for details. In addition to this, the following
log files will contain execution information.

— <System Tenp Dir or local FTP dir>/ ZODI _<Mapping
| d>_<SrcSet > <Cont ext >. out

— <SystemTenp Dir or local FTP dir>/ ZODl _<Mapping
| d> <SrcSet> <Context>. err

Refer to Log Files section in Application Adapters Guide for Oracle Data
Integrator for more details.

Refer to the individual KM options and their descriptions as well as to
Considerations for SAP ERP Integration section in Application Adapters Guide
for Oracle Data Integrator, for more information on the SAP ERP KM features and
options.

8.1 Going further with Oracle Data Integrator

ORACLE

Use the demonstration environment to familiarize yourself with Oracle Data Integrator.
You can go further with Oracle Data Integrator by taking advantage of the samples
available on the Oracle Technology Network.
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SAP ABAP ERP Required Privileges

This appendix lists the required privileges for accessing the SAP system using Oracle
Data Integrator.

An SAP dialog user is required for connecting to the SAP system, for the RKM
installation and for the LKM execution during development. A SAP RFC user is not
sufficient.

During development, this user must have a developer license key. License keys
can be retrieved from http://service.sap.com. Any execution attempts without this
developer license key will lead to failure and may cause the need for clean-up
operations.

For RKM and LKM execution in production, an SAP RFC user is sufficient.

These SAP user types can be used for the following operations:

Table A-1 Required SAP User Types

Operation Required SAP User Type

RKM: Setup SAP Dialog user

RKM: Reverse Engineering SAP Dialog user or SAP RFC user
LKM: Development SAP Dialog user or SAP RFC user
LKM: Production SAP Dialog user or SAP RFC user

The following tables list the privileges required for using SAP ABAP Knowledge
Modules.

e Authorizations Required for RKM SAP ERP Upload
e Authorizations Required for RKM SAP ERP Execution
e Authorizations Required for LKM SAP ERP Upload
e Authorizations Required for LKM SAP ERP Execution

A.1 Important points to consider

Consider the following points while configuring the SAP privileges:

 S_DATASET is an authorization object that controls access to physical file, so
you need to provide access to SAP directories & folder mounted path. The values
provided here are sample paths, you need to provide your landscape directories
path or provide *(all).

* NRor (NR) means NOT REQUIRED.
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Appendix A

Authorizations Required for RKM SAP ERP Upload

A.2 Authorizations Required for RKM SAP ERP Upload

The following SAP authorizations are required only in rare cases, when explicitly
requested by Oracle product support. For standard installations, these authorizations

are not required.

It is not required in TR-based installation.

" Note:

Developer key is required in this authorization.

Object Field Name Value (ECC6-EHP3) Value (ECC6-EHP7) &
(ECC6-EHP8)

S RFC ACTVT 16 16

S RFC RFC_NAME RFC1, SDI FRUNTI ME, RFC1, SDI FRUNTI ME,
SUTL, SYST, SUTL, SYST,
200l _FGR_PROD*, 200l _FCR_PROD*,
Z0DI _FCGR Z00 _F&R

S RFC RFC_TYPE FUGR FUGR

S _TCODE TCD SU53, SE38 SE38, WE30, SU53

S ADM _FCD S ADM _FCD NR RFCA

S CTS_ADM CTS_ADMFCT TABL TABL

S_CTS_SADM CTS_ADMFCT NR TABL

S_CTS_SADM DESTSYS NR *

S_CTS_SADM DOVAI N NR *

S _DATASET ACTVT 34 33, 34

S_DATASET FI LENAMVE * *

S_DATASET PROGRAM SAPLSTRF *

S TABU D' S ACTVT 3 02, 03

S TABU D' S DI CBERCLS * *

S_TABU_NAM ACTVT NR 02, 03

S _TABU_NAM TABLE NR *

S DEVELCOP ACTVT 01, 02, 03 01, 02, 03, 06

S DEVELCOP DEVCLAS $TMWP, ZODI _LKM PCKG, $TMP, ZODI _LKM PCKG
20Dl _RKM PCKG 20D _RKM PCKG

S DEVELCOP OBJINAME Z$$$XRFC, ZODI * Z$$SXRFC, ZODI *

S DEVELCP OBJTYPE DEVC, FUGR, FUNC, DEVC, FUGR, FUNC,
PROG PROG

S DEVELCOP P_GROUP Y

S _PROGRAM P_ACTI ON NR BTCSUBM T, SUBM T,

VARl ANT
S_PROGRAM P_GROUP NR *
ORACLE A-2
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Object Field Name Value (ECC6-EHP3) Value (ECC6-EHP7) &
(ECC6-EHP8)

S_SYS_RWBO ACTVT NR 01, 02, 03, 05, 06,
23

S_SYS_RWBO DESTSYS NR *

S_SYS_RWBO DOVAI' N AR v

S_SYS_RWBO TTYPE NR DTRA

S_TRANSPRT ACTVT 01, 03 01, 02, 03, 06

S_TRANSPRT TTYPE DTRA, TASK *

S_| DOCDEFT ACTVT NR 3

S_| DOCDEFT EDI_CIM AR

S_| DOCDEFT EDI _DCC AR

S_| DOCDEFT EDI _TCD NR

A.3 Authorizations Required for RKM SAP ERP Execution

The following SAP authorizations are required for reverse engineering the SAP models

using RKM SAP ERP.

Object Field Name Value (ECC6-EHP3) Value (ECC6-EHP7) &
(ECC6-EHP8)

S RFC ACTVT 16 16

S RFC RFC_NAME RFC1, SDI FRUNTI ME, RFC1, SDI FRUNTI ME,
SUTL, SYST, SUTL, SYST,
ZODl _FGR_PROD*, Z0Dl _FGR_PROD*,
200 _FCGR Z00 _FQR

S RFC RFC_TYPE FUGR FUR

S_TCCODE TCD SU53, SE38 SU53, SE38

S CTS_ADM CTS_ADMFCT NR TABL

S _DATASET ACTVT NR 34

S_DATASET FI LENAVE NR *

S_DATASET PROGRAM NR SAPLSTRF

S TABU D' S ACTVT 03 02, 03

S TABU DI S DI CBERCLS * *

S _TABU_NAM ACTVT AR 02, 03

S_TABU_NAM TABLE NR *

S_TRANSPRT ACTVT 01, 03 01, 03

S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK

A.4 Authorizations Required for LKM SAP ERP Upload

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in SAP development environment with Upload ABAP Option Enabled.

ORACLE
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< Note:

Appendix A

Authorizations Required for LKM SAP ERP Execution

Developer Key is required in this authorization.

Object Field Name Value (ECC6-EHP3) Value (ECC6-EHP7) &
(ECC6-EHP8)

S RFC ACTVT 16 16

S RFC RFC_NAVE RFCL, SDI FRUNTI ME, RFC1, SDI FRUNTI ME,

SYST, ZODI _FGR, SYST, ZODI _FGR,
Z0DI _FGR _PRCD * Z0DI _FGR _PRCD *

S RFC RFC_TYPE FUGR FUR

S _TCODE TCD SU53, SE38 SE38, SU53

S ADM _FCD S ADM _FCD RFCA, SFTP RFCA, SFTP

S BTCH _ADM BTCADM N Y Y

S_BTCH JOB JOBACTI ON RELE RELE

S BTCH JOB JOBGROUP " v

S CTS_ADM CTS_ADMFCT TABL TABL

S _DATASET ACTVT 06, 33, 34 06, 33, 34

S _DATASET FI LENAMVE * *

S_DATASET PROGRAM * SAPLSLOG, SAPLSTRF,
SAPLZ*, ZODl *

S DEVELCOP ACTVT 01 01

S DEVELCOP DEVCLASS * *

S_DEVELCP OBJNAVE ZODl * Z0Dl *

S DEVELCOP OBJTYPE FUGR, FUNC FUGR, FUNC

S DEVELCP P_GROUP NR

S_TRANSPRT ACTVT 01, 02 01, 02

S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK

S APPL_LOG ACTVT 06 6

S APPL_LOG ALG_OBJECT ZCDl _APPCBIJ ZCDl _APPOBJ

S APPL_LOG ALG_SUBGOBJ Z0Dl _SuBOBJ Z0Dl _SUBCBJ

S TABU DI S ACTVT 3 3

S TABU D' S DI CBERCLS * *

A.5 Authorizations Required for LKM SAP ERP Execution

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP production environment, when LKM option Upload ABAP Code is

ORACLE

disabled (QA or Production).
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Authorizations Required for LKM SAP ERP Execution

Object Field Name Value (ECC6-EHP3) Value (ECC6-EHP7) &
(ECC6-EHP8)
S RFC ACTVT 16 16
S RFC RFC_NAME RFC1, SDI FRUNTI ME, RFC1, SDI FRUNTI ME,
SYST, ZODI _FGR PROD*  SYST,
20Dl _FGR_PROD*, RFC_ME
TADATA
S RFC RFC_TYPE FUGR FUR
S ADM _FCD S ADM _FCD SFTP SFTP
S BTCH_ADM BTCADM N Y Y
S_BTCH JOB JOBACTI ON RELE RELE
S_BTCH JOB JOBGROUP v "
S _DATASET ACTVT 06, 33, 34 06, 33, 34
S _DATASET FI LENAMVE * *
S _DATASET PROGRAM SAPLSLOGF, SAPLSTRF*, SAPLSLOG*, SAPLSTRF*,
SAPLZODI *, ZODI *, SAPLZQDI *,
SAPLZCDI _FGR_PRCOD* SAPLZCODI _FGR_PROD*,
20D *
S_TRANSPRT ACTVT 01, 02 01, 02
S_TRANSPRT TTYPE DTRA, TASK DTRA, TASK
S APPL_LOG ACTVT 06 06
S APPL_LOG ALG_OBJECT ZCDl _APPCBJ ZCDl _APPOBJ
S APPL_LOG ALG_SUBOBJ Z0Dl _SUBOBJ ZODl _SUBCBJ
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SAP Stand-Alone Connection Test

This appendix describes how to perform an SAP stand-alone connection test.
In addition to the Connection Testing described above, a test can be performed
outside of ODI using a standalone java utility.

B.1 SAP Stand-Alone Connection Test

To use a standalone java utility to test the connection:

1. Open a command window.

2. Change to <ODI _HOVE>/ odi / sdk/ | i b directory.

3. Make sure that JAVA_HOME points to a JVM (at least 1.5).
4

Make sure that you have installed SAP Java Connector and that the sapj co3. j ar
and the sapjco3 library are in the <ODI _HOVE>/ odi / sdk/ | i b directory.

5. Launch the utility using the following command:
On Windows:
java -cp sapjco3.jar;odi-sap.jar oracle.odi.sap. kmtest.JCoTest
On Linux/UNIX:
java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap. kmtest.JCoTest

This should result in an output similar to this:

0D LE

6. Use a text editor to open the ODI _SAP_CON PQOQL. j coDesti nati on file in the
oracl edi/ drivers directory. The file should look like this:

#for tests only!

jco.client.lang=EN

jco.destination. peak_|init=10
jco.client.client=800
jco.client.passwd=<SAP Passwor d>
jco.client.user=<SAP User>
jco.client.sysnr=00

j co. destination. pool capacity=5
jco.client.ashost=<SAP Application Server>
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7. Enter your SAP connection information, which you have received from your
SAP administrator. The file will then look similar to this (use your connection
information!):

#for tests only !
jco.client.lang=EN

j co.destination.peak_|init=10
jco.client.client=800
jco.client.passwd=0Dl 123
jco.client.user=0Dl
jco.client.sysnr=00

j co. destination. pool _capacity=5
jco.client.ashost=123.123. 123. 123.

8. Launch the utility again using the following command:
On Windows:
java -cp sapjcod.jar;odi-sap.jar oracle.odi.sap.kmtest.JCoTest
On Linux/UNIX:
java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap. kmtest.JCoTest

This should result in an output similar to this:

MO S sy stem 32 omd.exe

java —ep odi-sap.jar;sapjcod.jar oracle.odi.zsap.kn.test . JCoTest

ODI _SAF_COH_POOL

1108
150885 _1
izo=-8B85%-1

In addition to just testing the SAP connection, the utility will also validate the
existence of certain Function Modules required for the RKM. These are installed
during first execution of the RKM (UPLOAD_ABAP_CCDE and UPLOAD ABAP_BASE set to
true).
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9. Delete the ODI _SAP_CON POOL. j coDesti nati on file after execution, as it contains
the SAP login credentials.
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Uninstalling ODI SAP Components

This appendix describes how to uninstall ODI components from your SAP system.
For removing ODI connectivity from the SAP system, please follow the steps
described in this section.

Please note that this will delete ALL components including generated extractor
programs.

C.1 Updating ODI SAP Components

During first-time installation the TR installs some ODI objects into the SAP system.
This installation consists of two parts: some base objects and some RFCs. Such full
installation requires that no ODI SAP objects are installed in the SAP system. See
Uninstalling ODI SAP Components if needed.

If the ODI objects installed into your SAP systems have been installed by RKM SAP
ERP v34 or later / RKM SAP BW v25 or later, there is no need for reinstalling the base
objects and it is sufficient to update just the RFCs. Reinstalling the RFCs is achieved
by executing a reverse engineering run with RKM option UPLOAD ABAP_BASE set to

fal se and RKM option UPLOAD ABAP_CODE setto true.

C.2 Uninstalling ODI SAP Components

To upgrade to a newer ODI SAP Connector release or to permanently remove the ODI

connectivity:

1. Start the SAP GUL.

2. Connect to the SAP systems you want to uninstall.

3. Go to the transaction SE8O.

4. Select the package or development class option from the drop down box.

5. Enter ZODI _RKM PCKGin the package or development class field. Note that for older

installations the package name is ZODI _DEVCLASS.
Right-click the ZODI _RKM PCKG object below the object name tab.

o

7. Select Delete in the drop down menu and delete the development class.

If it does not allow deleting the development class individually, delete all the
objects inside one by one. For the contained Function Group please make sure
to delete it in one go and do not delete the Function Group's Function Modules
individually. Once all objects have been removed, delete the development class
itself.

8. Go to transaction SE10. Select Modifiable and Workbench Requests. Click
Display.

9. Select the transport requests which have the ODI Objects and Release them.

10. Now repeat the steps 3 to 7 to delete Development Class.
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11. Go to transaction SE01. Select Modifiable and Workbench Requests. Click
Display. Release the Transport Request which has ZODI _RKM PCKG.

12. Repeat Step 4 to 11 for package ZODI _LKM PCKG.
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